
 

Learning Guide 
Edit and Animate 3D Models with Spline 
 
Introduction 
Spline is a free-to-start 3D creation tool that allows users to create interactive 3D designs. Spline requires no coding experience and runs on 
a web browser. You can explore different materials, effects, and animations in Spline, and apply them to a 3D model you’ve created using a 
different tool. 

This Guide will show you how to bring your own 3D models into Spline and add materials and animations to create interactive 3D 
experiences. These skills can help you elevate and customize your website with the unique designs you’ve created in Spline, or add your 
designs to other 3D projects to make them more dynamic and visually appealing.  

 
Video Learning Guide for this Lesson: 

https://www.youtube.com/watch?v=YW6UZpiIiV4 
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https://www.youtube.com/watch?v=YW6UZpiIiV4


 

 
Prior Knowledge Check 
This Guide assumes that you already have a 3D model that you will import into Spline to which you’d like to add materials and animations. 
Your 3D model should be in .fbx, .obj, or .glb/gltf file format.  

You can follow this Guide by using a 3D model that you’ve created with any 3D modeling tool, or explore our Learning Guides to create a 
unique model of your own: 

●​ Create 3D Models with Tinkercad 
●​ Create 3D Models with SculptGL 
●​ Generate 3D Models with Meshy 

To follow this Guide seamlessly, it is suggested that you work with an external mouse on your computer. Some functions may not be 
available with a laptop trackpad. 

 

https://www.youtube.com/watch?v=yog_pwkztHU
https://www.youtube.com/watch?v=oPffpjMsdpc
https://www.youtube.com/watch?v=RnOX5adwZ7k


 

Step 1: Import a 3D model into Spline 
 
Preview 
To create an interactive 3D design in Spline, the first step is to bring in the 3D model you’ll be working with. This section will help you start a 
project in Spline and import your model. 

 
Experiment 
 
 

LOG INTO SPLINE 
 

Visit Spline on https://spline.design. Log in or create an 
account. 
 
If creating an account for the first time, you will be 
prompted to answer some questions. Your answer to these 
questions will not change your ability to use Spline. 
 
Spline might suggest upgrading to a paid plan, but you can 
decline the offer and get started with Spline for free. 
 
 
 
 
 
 

 

https://spline.design


 

 
 
 

CREATE A NEW PROJECT 
 
Click on the “+ Create” button in the top right corner and 
select “3D Design” to create a new project in Spline. You 
can also find this option in the middle of your main screen. 
 
If using Spline for the first time, you will be prompted to 
follow a tutorial when you create your first project. 
Complete or skip the tutorial before following the next 
steps. 
 
 
 
 
 
 
 

 
NAVIGATE THE VIEWPORT 

 
The viewport is the 3D interactive window in the middle of 
your screen. 
 
To rotate around in the viewport in Spline, hold ALT 
(OPTION for macOS) and use the Right Mouse Button.  
 
To pan, click on the Middle Mouse Button and drag.  
 
Zoom in or out with the Scroll Wheel.  

 



 

 
 
 

 
 
 
Before importing your model, click on the pre-existing 
rectangle shape in your viewport, and delete it by pressing 
the DELETE key. 
 

 
 
 
 
 
 
 
 
 

 
 

IMPORT YOUR MODEL 
 
Click on the Import button on the bottom-left corner of the 
screen. 
 
 
 
 
 
 

 



 

 
 
 
 
 
 
 
Choose the 3D Model option.  
 
From the file selection window, navigate to the folder that 
contains the 3D model you would like to import. 
 
 
 
 
 
 
 
 
 
 
 
 
If using a model exported from Tinkercad, the downloaded 
folder will include two files. Hold SHIFT to select both files 
and click “Open” to import them to Spline. 
 
If you have any issues importing a Tinkercad model, make 
sure you’ve unzipped the downloaded file from Tinkercad. 
Right click on the zipped file and select “Extract all…”. 
 
You can also import any other 3D model you have on your 
computer, as long as the file format is in .fbx, .obj, or 
.glb/gltf format. 
 

 



 

 
 
 
 

 
You should now see your 3D model imported to the middle 
of the Viewport. 
 
Everything you add to your Spline project will be listed in 
the Outliner panel on the left. 
 
 
 
 
 
 
 
 
 
 
 
 
 
If your imported file contains multiple parts, they will show 
up under a “Group” in the outliner. 
 
When you need to select all the parts of your model (to 
edit, move, etc.), you need to click on “Group” from the 
Outliner.  
 
If you need to select a specific model, you can double 
click on the part in the Viewport or select it individually 
from the Outliner. 
 

 



 

 
 
 
 

MOVE YOUR MODEL 
 
Select a model, or the entire group, you want to move.  
 
You can move the model in different directions by clicking 
and dragging the red, green, and blue colored arrows (1) 
and rotate it by using the colored handles (2). 
 
 
 
 
 
 
 
 
 
 
 
 
 
If you import a model, it might be facing the wrong direction 
upon import. 
 
To fix this, make sure the group is selected from the 
Outliner if your model contains multiple parts. 
 
Then, on the right panel, click on the “Rotation X” value 
and type on your keyboard to set it to “-90”. 
 
 

 



 

 
 
 
To scale your model, click and drag on the small spheres 
(3) where the arrow and handles meet. However, keep in 
mind that this will scale your model in only one direction. 
 
If you’d like to be more precise with your scaled model, or 
make sure it’s scaled correctly in all directions, use the 
Transform window on the right and enter numbers on your 
keyboard. 
 
For example, typing “2” on all X, Y, Z, boxes will double the 
size of your model uniformly. 
 
 
 
 
 
 
 

Self Check 
Were you able to bring in your model successfully and move it the way you wanted?  



 

Step 2: Edit materials 
 
Preview 
Depending on the file you imported, your 3D models might already have color and materials applied to them, or they might just be 
white/gray. Regardless, Spline’s own material setup will give you the opportunity to customize your materials even more. This section will 
show you how Spline’s layered materials work. 

 

Experiment 
 
 
 
 

ADD MATERIALS 
 

Select a model in the Viewport to change its material.  
 
As a reminder, if you want to select an individual model 
instead of an entire group, double click it in the Viewport or 
select it individually from the Outliner. 
 
On the right menu panel, go to the Material section. 
 
 
 
 
 

 



 

 
 
 
 
 
 
The model might already have a basic color applied to it.  
 
Click on the square next to “Color” to change the color of 
your model. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Pick the color you want from the color picker window and 
the new color will apply to your selected model. 
 

 



 

 
 

ADD MATERIAL LAYERS 
 

The Materials system in Spline works in layers, which is 
similar to adding multiple filters on top of each other to 
achieve the look you want. By using the layers system, you 
can create more complex materials and looks. 
 
For example, instead of a solid color on your model, you 
can create a swirling mix of shades. 
 
First, click on the + icon next to the Material section to add 
a new layer.  
 
 
 
 
 
 
 
 
 
 
By default, Spline creates a gray “Color” layer, which goes 
on top of other layers and overrides them. 
 
You will notice that your model has turned solid gray, 
because the “gray” Color layer is now on top of the 
previous Color layer. 
 

 



 

 
 
 
 
 
 
You can change this layer to a Noise layer (or any other 
type of layer) by clicking on the small dropdown arrow 
next to the “Color” layer you just created and selecting 
“Noise”. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
This option will create a layer that has a random noise 
pattern and 4 different color options. To increase the visual 
interest of the Noise layer, click on the square next to the 
Noise dropdown and edit the settings.  
 

 



 

 
 
 
 
 
 
Change the scale setting until you achieve a grayscale 
pattern you like. Try a low number like “0.10.”  
 
Then, change the four color options to make the noise 
pattern more colorful. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The number “100” next to a layer indicates the opacity of 
that layer. If you bring the opacity of the Noise layer to “50”, 
you will notice that the pattern you’ve created becomes 
half-transparent and you can see the original color layer 
underneath come through. 
 
 
 
 

 



 

 
 
 
 
You can also change the order of layers to decide what sits 
on top. Click on the layer you want to move and drag it up 
or down to change its order.  
 
This is one of the advantages of working with layered 
materials in Spline. Changing layer orders or opacity will let 
you test different looks without permanently changing your 
materials. 
 
 
 
 
 
 
 
 
 
 
 
 
 
To customize your material even more, add a new layer 
with the + icon and this time, choose “Outline” from the 
dropdown menu. This layer will add a stylistic outline 
around your model based on the camera angle. 
 
Adjust the opacity or other “Outline” settings as you wish. 
 
 
 

 



 

 
 
 
 
If you wish to check how your material would look without a 
certain layer, you can hide a layer temporarily by clicking 
the eye icon next to the layer you would like to hide. 
 
This is very helpful when you create a material with many 
layers and don’t remember exactly what each layer does.  
 
If you’d like to delete a layer completely, hover over the 
layer you want to delete and click on the small x icon on 
the right side of the layer. Keep in mind that this will 
completely remove that layer and all its settings. 
 
 
 
 
 
 
 
 
Play around with different material layers and setups to 
explore what you like. Remember, you can apply different 
materials to each of the models in your project and have 
them all look different! 

 
 
 
 
 
 
 

Self Check 
Were you able to achieve the look you wanted using different materials and layers? 



 

Step 3: Add effects to your project 
 
Preview 
This section will show you how to add different visual effects to your Spline project. These effects will apply to your entire project and 
change the look of everything simultaneously. 

 

Experiment 
 
 
 
 
 

SELECT AND ADD AN EFFECT 
 

Click on an empty area in the Viewport to open the general 
settings on the right. You can find all the available effects in 
the Effects dropdown on the right panel.  
 
Toggle on the effects to make sure they will apply to your 
project. 
 
 
 

 



 

 
 
 
 
Click on the dropdown arrow to see all the effect options. 
 
Pick any effect you would like to apply to your project. Turn 
on the effect by toggling the eye icon on the right side of 
the effect. 
 
The percentage slider next to the icon will determine how 
strongly the effect applies to your project. The default is 
100%, but you can lower it to have a more subtle change. 
 
 
 
 
 
 
 
 
 
 
 
 
All effects have special settings of their own. You can find 
these settings by clicking the settings icon next to each 
effect. Try different options and see what works for your 
project. 
 
 

 



 

 
 
DoF stands for Depth of Field and will add a camera blur effect to the 
Viewport. 
 
Pixelation lowers the resolution of the Viewport and creates a 
pixelated look. 
 
Aberration uses the RGB (red, green, blue) values of the colors in 
the Viewport to add a layered effect. 
 
Bloom makes the objects in the Viewport glow. 
 

 

Hue shifts all the colors in the Viewport to a different one 
based on its value. 

Brightness increases the overall brightness/white value of the 
Viewport. 

Vignette will add a filter to darken the edges of the Viewport 
for an artistic look. 

Noise overlays a noise layer to the Viewport, making 
everything look jittery. 

 
 
 
 
 
 
 
 
 
 
Self Check 
Which effects did you use in your project? Were you able to use multiple effects to create a look that you liked?  



 

Step 4: Animate your model 
 
Preview 
After you have imported your models into Spline and applied materials to them, you can now animate them. This section will explain how 
animation States and Events work in Spline and how to set up different types of animation sequences. 

 

Experiment 
 
 
 
 
 

ADD STATES 
 

In Spline, States act as the defined positions at key points 
during a model’s animation. Animations are created by 
setting up transitions between different States. 
 
Start by selecting a model you want to animate and go to 
the States section on the right panel.  
 
Click the + icon to add a new State. Two new states will 
appear: Base State and State. 
 

 



 

 
 
 
 
 
Base state is the starting position of your model in the 
animation. 
 
State is the next step in the animation. Here, you need to 
change your model’s location, rotation, and/or scale to 
create some movement. 
 
 
 
 
 
 
 
 
 
 
 
 
 
To start animating, make sure State is selected and 
change your model’s location, rotation and/or scale. 
 
For example, move your model to a higher position.  
 
Switching between “Base State” and “State” by clicking on 
each will show you the differences. These will be the first 
and second positions of your animation. 
 
 
 

 



 

 
 
 
 
 
 
If you’d like to add more positions to your animation, click 
on the + icon again to create a new state. 
 
Select State 2 and change your model’s location, rotation 
and/or scale like before. 
 
For example, make your model larger. 
 
 
 
 
 
 
 
 
By clicking through each state, you can now see the 
different positions saved to “Base State”, “State”, and 
“State 2”. 
 
Feel free to add more states to your animation as you 
wish. 
 
In this example, we have the “sun” model in the following 
states: 

●​ Base State: default location, starting point 
●​ State: location change, higher location 
●​ State 2: scale change, larger model 

 
When setup is complete, the model is going to transition 
smoothly between these 3 States. 



 

 
 
 

ADD EVENTS 
 
Events help connect your States together to create 
transitions. 
 
To create an Event, make sure your animated model is 
selected, and go to the Events panel on the right. Click the 
"+" icon to create a new event. 
 
 
 
 
 
 
 
 
 
 
 
 
 
A new panel will appear for the Event you’ve created. 
Under the “Actions” section, select Transition. 
 
The Transition option allows you to create animations 
using the States you created. 

 



 

 
 
 
 
 
Click on the Transitions tab to open it. It will be populated 
with 2 dropdowns. 
 
For dropdown 1, select “Base State”. 
 
For dropdown 2, select “State”. This is the order of your 
model’s movement during animation. 
 
 
 
 
 
 
 
 
 
 
 
 
If you have more than 2 states created for your animation, 
add a new dropdown by clicking the + icon in the 
Transitions section. 
 
Select “State 2” for the third dropdown. 
 
Repeat this step as needed based on the number of states 
you’ve created. By selecting the states in a different order 
from the dropdowns, you can change the order of your 
animation if desired.  
 

 



 

 
 
 
 
 
 
To test your animation, click on the Play icon at the top 
menu. You will see a preview of your Spline project with 
the animation. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Your animation will play once in the preview. You can still 
navigate around in the 3D space.  
 
When done testing, click on the X icon to close the Play 
preview window. 

 



 

 
 
 
To make your animation loop, instead of playing once, 
head to the “Sequence” section at the bottom of the event 
window. 
 
In the Loop dropdown, select “Count” for a definite number 
of loops or “Infinite” for a non-stop cycle. 
 
In the Cycle dropdown, select “Ping Pong” to make your 
animation loop back and forth. 
 
Use the Play icon again to test your looping animation. 
 
 
 
 
 
 
 
 
 
 
By default, the animations you create will start as soon as 
the webpage loads (or the Play button is pressed). You can 
change this and make the animation start based on a 
specific trigger (mouse movement, keyboard press, etc). 
 
At the top of the Events window, click on the Start 
dropdown and select a different trigger. 
 

 



 

 
 
 
 
For example, Mouse Hover will make your animation start 
only when the viewer’s mouse hovers over the animated 
shape. If the mouse does not move over your shape, the 
animation will not play. 
 
Choose different triggers and test them by using the Play 
icon at the top menu. 
 
These settings will carry over if you choose to add your 
Spline project into a different application or website, and 
can help you create an interactive experience for the 
viewers. 

 
 
 
 
 
 
 
 
 
 

Self Check 
Did you create the states and events that resulted in an animation you liked? Did you add a different trigger to your animation? 

 

 

 



 

Step 5: Experiment with additional features in Spline  
 
Preview 
Once you understand the basics of animation in Spline with States and Events, you can use the same concepts to animate other 
components of your project as well. This section will show you some additional techniques for making dynamic animations in Spline. 

 

Experiment 
 
 
 
 
 

ANIMATE MATERIALS 
 

In addition to making your whole 3D model move, you can 
use States to make the materials on the surface of your 
model move. 
 
Click and select the model you want to animate the 
material of. From the Materials panel on the right, add a 
Noise layer. 
 
 

 



 

 
 
 
 
Set the “noise size” and “color” as desired as learned in the 
previous sections. 
 
Next, make sure that the Movement setting is set to “1”. 
This setting changes the position of the material layer on 
your model.  
 
Experiment with the rest of the material settings freely. 
 
 
 
 
 
 
 
 
 
 
 
 
When you’re happy with the material, create States for 
your model. 
 
Select State and leave the Base State as-is. 
 
In the same way you can move an object between states, 
you can move the material on the surface of the object as 
well.  



 

 
 
 
 
 
 
 
After selecting State, go to the settings for Noise material 
and set the Movement setting to “10”. 
 
 
 
 
 
 
 
 
 
 
 
Now, if you click between State and Base State, you 
should see a difference on the surface material of your 
model.  
 
What we achieved with this setup is different material 
“Movement” values at 2 different states. 
 
At the beginning (Base State), the material Movement will 
have the value of “1”. 
 
At the end (State), the material Movement will have the 
value of “10”. 
 
By transitioning between these two States, we will be 
creating a smooth animation that happens on the surface 
of the model.  



 

 
 
 
 
Create an Event. Choose the “Transition” option and set 
the first transition to be “Base State” and the second to be 
“State”. (This is the same setup we used to animate our 
whole 3D model previously.) 
 
You can set up the loop options to your own preference. 
 
When you press Play at the top menu to view your project, 
you will see the material on your model shift with an 
animation. 
 
 
 
 
 
 
 
 
 
If you notice that the animation is moving too slow or fast, 
you can edit it within the Event settings. 
 
The number box between the transitions determines how 
many seconds the transition takes. Change this to a 
higher number to slow down your animation, or lower 
number to speed it up. 
 
Press Play to test your new animated material. 

 



 

 
 

ANIMATE ALONG A PATH 
 

Previously in Step 4, we learned how to animate a model 
between different states in the 3D space. Using the same 
animation concepts in Spline, you can also animate a 
model along a path. 
 
Animating along a path gives the creator the opportunity to 
create smoother and more complex animations. With this 
method, instead of going from “point A” to “point B”, the 
model will follow a full path that is created separately. 
 
To start, click the + button at the top menu and select 
Path from dropdown. 
 
 
 
 
 
 
 
 
Click anywhere in the Viewport to start creating a path. 
 
To create rigid lines, keep clicking along the Viewport.  
 
To create curved lines, click and drag while creating the 
points.  
 
 

 



 

 
 
 
 
 
 
Use the Arrow tool from the top menu to move the points 
after they’ve been created. 
 
Or use the X button to exit the editor when you’re done 
creating the path. 
 
 
 
 
 
 
 
 
 
 
 
 
By default, this tool will create a gray cylinder along the 
path. For animating, we only need the invisible path, not 
the cylinder model. 
 
Click on the path you created to make sure it’s selected. 
On the “Materials” panel on the right, disable the Light and 
Color layers with the eye icon. 
 
This will make the cylinder invisible, so we can focus on 
using the path only for our animation. 
 

 



 

 
 
 
 
 
 
Now, click and select the 3D model to move along the 
path. 
 
Find the “Modifiers” section in the right panel and use the 
+ button to add an Align to Path modifier. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
In the “Edit Modifier” window, use the Object dropdown 
and select the “Path” you created. 

 



 

 
 
 
 
 
 
Once the “Path” is selected, your model will automatically 
move to the beginning of the path. 
 
You will also see additional settings in the Modifier window. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Create a State for the model. If a State already exists, you 
can use the existing one. 
 
Make sure you’re set on the Base State. 
 

 



 

 
 
 
 
 
Back in the modifier, find the Slide option. Slide will move 
your object along the path. 
 
Use one of these sliders to determine where you want your 
object to start the animation. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Now, select the State option. 
 
Move the Slide slider again to determine where you want 
your model’s animation to end. 
 
By moving the slider to a new value and making a change, 
the State will automatically update. 
 
 
 

 



 

 
 
 
 
What we achieved with this setup is 2 different locations 
along the path for our animated model. 
 
At the beginning (Base State), the model is at the start of 
the path. 
 
At the end (State), the model is at a different location on 
the path. 
 
When we create an Event to connect these two states, the 
model will automatically and smoothly move from the 
beginning of the path to the end. 
 
 
 
 
 
 
 
 
 
 
Make sure an Event is set up as we’ve learned previously 
to transition between the States. 
 
When ready, you should see your object move along the 
path when the project is in Play mode. 
 
 
 
 

 



 

 
 

ADD PARTICLE EFFECTS 
 

Particle effects are 3D systems that are made up of a large 
number of small objects. They can be used to create 
effects like smoke, explosions, fireworks, magic effects, 
and many more that can be customized creatively. 
 
In Spline, you can create particle effects by using the 
Particle Emitter object. 
 
Click the + button at the top menu and select Particle 
Emitter. Click anywhere in your Viewport to add the new 
Emitter. 
 
 
 
 
 
 
 
Use the settings on the right panel to customize the 
Particle Emitter. You can change the color, speed, size 
and other properties of particles. 
 
Birth rate determines how many particles are created 
within a second.  
 
Life time determines how long each particle exists before 
fading out. The longer this time is, the further the distance 
the particles will travel. 
 

 



 

 
 
 
 
You can animate the Particle Emitter like any other object 
within Spline with “States” and “Events”. 
 
You can also make the Particle Emitter follow an 
already-animated model in your project. 
 
In the Viewport, position the Emitter in relation to the model 
you want it to follow. In the example on the right, the 
Emitter will be following the car and is attached to the back 
of it. 
 
 
 
 
 
 
 
 
 
 
 
 
Then, in the Outliner panel on the left, drag the Emitter on 
top of the animated model until it becomes a child and let 
go when it’s attached.  
 
The Emitter should show up under the attached object in a 
dropdown. 
 
 

 



 

 
 
 
 
 
When an object becomes the “child” of another, it will 
follow the same movement, rotation, and scale changes 
made to its “parent”.  
 
In our example, the Emitter (child) will be attached to the 
animated car model (parent) and follow its movements.  
 
Press Play to see the Emitter follow the animation of the 
“parent” object. 
 
 
 
 
 
 
 
 

Self Check 
Did you find the additional tools helpful? Were you able to create new animations with materials, paths, or particles? 
 

 



 

Step 6: Export your project  
 
Preview 
Once your Spline project is ready, you can export an “embed code” which will enable you to place your project within a different website. This 
section will show you how to export your embed code, as well as how to share your project in Spline with others. 

 

Experiment 
 
 
 
 

EXPORT FOR THE WEB 
 
 
Click the Export button from the top-right corner of the 
window. 
 
 
 
 
 
 

 



 

 
 
 
 
Under the Web category, select Viewer to generate an 
embed code for your animation. 
 
With this code, you will be able to integrate your Spline 
project into different websites or other web-based 
applications. 
 
Click on Copy Embed and save the code to use in your 
website or other applications. 
 
 
 
 
 
 
If you would like to share your projects with others within 
Spline’s own website, instead of exporting it to a web 
application, you can also do so from the Export settings. 
 
Select the “Public URL” option in the Export window and 
select “Copy Link”.  
 
This will give you a shareable link of your project. Others 
who have this link will be able to paste it into their browser 
and view and interact with your Spline project without 
needing to create an account. 
 
 

Self Check 
Were you able to find and copy your embed code successfully? Did you try to use a public link of your project and share it with others?



 

Lesson Closure 
 

Demonstration of Learning 
You now know how to bring your own models into a Spline project and add materials to each model. You have a core understanding of how 
States and Events contribute to creating animations in Spline and how to make them more interactive by adding custom triggers based on 
user actions. You also learned new techniques within Spline to bring your project to the next level, and share it with others through embed 
code and public links. 

 

Exploration Opportunities 
 

You can use the embed code generated from Spline in a variety of other web applications. If you’re interested in learning how to use the 
embed code in a personal website of your own, check out the following lesson:  
​ Create a Website with 3D Animations in Google Sites  

 

https://www.youtube.com/watch?v=fPk0K319bu8
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